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================================== Fi I e Menu 
Fiie Menu 

New 
Open ... 
Catalog ... 
Open Selection 
Close 
Snue 
Snue As ... 
Reuert To Snued 
Get Info ... 
Preferences 
Snue Preferences 

Layout Page .. . 
Page Setup .. . 
Print ... 
Merge ... 

Transfer ... 
Quit 

XN 
XO 

xw 
XS 

XQ 

New 
Opens a new "Untitled" file. 

Open ... 
Allows you to open files. 

Catalog ... 
An alternative to Open .... Allows you to open one or 
any number of files. 

Nlsus® Only: Displays 
only the names of files cre­
ated by Nisus. 

Nlsus® Readable: Dis­
plays names of all files read-
able by Nisus. 

Nlsus8 Only 
v'Nlsus8 Readable ,'.It 

Nlsus8 Macro 
· Nlsus8 Glossary 
Nlsuse Dlctlon11ry 
Mlcrosoft8 Word 
M11cWrttee 
All Flies 

Nlsus® Macro: Displays only the names of Nisus 
macro files. 

Folders Only 
Rend Only 

Rdd To Search List 
Remoue From Search List Nlsus® Glossary: Displays only the names of 

Nisus glossary files. 
1-----------

Delete ... 
Moue/Rename ... 
EJect Nlsus® Dictionary: Displays only the names of 

Nisus dictionaries, user dictionaries, hyphenation 
· and thesaurus files. 

Microsoft® Word: Displays only the names of Microsoft Word files. 

MacWrlte®: Displays only the names of MacWrite 
Modified Catalog Menu files. 

Nlsus8 Only 
v'Nlsus8 Readable 

Nlsus8 Macro 
Nlsus8 Glossary 
Nlsus8 Dictionary 
Mlcrosoft8 Word 
M11cWrlte8 
All Flies 
folders Only 
Rend Only 

1-------····--·-------
Rdd To Search List 

!Clear Search list! 
I-· 

Delete ... 
Moue/Rename ... 
Ejecl 

Option 
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All Flies: Displays the names of all files. 

Read Only: Allows you to read a file opened in this 
mode, but does not allow you to change it. 

Add To Search List: Adds files to your Search 
List, allowing you to search unopened files. 

Remove From Search List: Removes selected files 
from your Search List. 

Clear Search List: (OPtIOO) .Aemoue From 

Search List. Removes all files from your Search List. 

Delete ... : Brings up a dialog that enables you to delete 
the selected file, without returning to the Finder. 



Move/Rename. , Brings up a dialog that enables you to move the selected 
file to another folder or rename it, without returning to the Finder. 

Eject: Ejects the current disk from the drive, allowing a new disk to be 
inserted. 

Modified Fiie Menu 

lneuert Rll Changed! 
Gel Info ... 

2 

ICW 
ICS 

Preferences ~ Preferences ~ 
Saue Preferences hue Preferences 

Transfer... Transfer ... 
i....;:.Q.;;.;.ul,;....t ____ x_Q._. Quit ICQ 

3 
New 
Open ... 
catalog ... 
Open Selectlon 
Close 
saue 
saue Rs ... 
jReuert If Newerj 
Get Info ... 
Preferences 
Saue Preferences 

Layout Page ... 
Page Setup ... 
Print ... 
Merge ... 

Transfer ... 
Quit 

4 
ICN ICN 
ICO ICO 

ICW 
ICS 

~ Preferences ~ 
Saue Preferences 

Merge ... 

Transfer ... 
ICQ Quit ICQ 

1) Option 2) Shift-Option 3) 3€Command 4) 3€Command-
Shift-Option 

Open Selection 
Opens files from within another document. Type the path to the file into your 
document. Later, select the "pathname" or "pathnames" and choose this command. 

Close 
Closes the current file, but does not quit the application. 

Close All 
@3 Close. Closes all files, but does not quit the application. 

Close All Unchanged 
[ 3€ Command ) [Shift) @3 CI o s e, Oases all unchanged files, but does not 

quit the application. 

Save 
Saves the current file, writing over what was previously saved. The previously 
saved file becomes the updated .bak file when Save .bak Files is set in the Seu Ing 
Files ... dialog accessed under the Preferences submenu. 
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~ ·e All Changed 
@ptio!i) Se lJ e .... Saves all changed files, writing over what was previously saved. 
The previously saved files become the updated .bak files. 

Save All 
(Shift) fQPtiOij) Seue. Saves all open files, writing over what was previously 
saved. The previously saved files become the updated .bak files. 

Save As ... 
Allows you to rename a file, switch folders or drives, or change the file type 
before saving. Saves as a new file rather than writing over the original one. 

Revert To Saved 
Reverts to the last saved version of the file, throwing away all new changes. If 
your document was changed, this brings up a yes/no warning dialog. 

Revert All Changed 
(option) Reuert To St'Wed. Reverts to the last saved versions of all open files, 
throwing away all new changes. 

Revert if Newer 
(3€ Command) Reuert To Seued. If a file is modified and saved in another 

program while also open in Nisus, this command makes the current Nisus file 
conform to those new changes. Without this command, those changes made in 
the other program will never appear in the open Nisus file. 

Revert All Newer 
(3€ Command) (Shift}( -0-p-ti-on-) Reuert To Seued. If files are modified and 

saved in another program while also open in Nisus, this command makes all 
open Nisus files conform to those new changes. Without this command, those 
changes made in the other program will never appear in the open Nisus files. 

Get Info ... 
Gives information about the file: where located, when created and modified, size, 
number of characters, words, sentences, lines, paragraphs and pages, average 
word length, average number of words per sentence, maximum number of words 
per sentence, Flesch reading ease and reading grade level. 

Preferences 
Submenu allowing you to set customized preferences for your current document 
and customized default preferences for all new files. 

Revert: Reverts to the preferences as they were originally shipped. 
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Start Up •.. : Sets Nisus Start Up options: show catalog, open new file, name 
new files "UntW' ' and show Clipboard at start up. 

\ ' 

Saving Flies ... : Sets options for saving: save .bak files, save after every 
(user defined#) key strokes and secondary disk save. 

Editing ... : Customizes the way text is handled in the editing window: intel­
ligent cut and paste, enable fractional font spacing, use MacWrite Clipboard, 
auto indent, remove trailing blanks when typing, remove leading blanks 
when typing and set maximum number of undos. 

Searching ... : Sets default settings of the Find/Replace dialog: ignore case, 
whole word, wrap around, Normal, PowerSearch or PowerSearch+, and 
skip "Text Not Found" dialog. 

Scrolling ... : Controls automatic scrolling and the maximum scrolling speed: 
auto horizontal and vertical scrolling, scroll to keep 36 pixels in view and 
show horizontal scroll bar. 

Measurement. .. : Deals with ruler dimensions and the info bar display of 
the cursor position. 

Printing ... : Specifies the default printer for deciding the printer limits used 
when no printer driver is selected in the Chooser dialog under the CA pp le 
menu. Also controls the order pages are printed. 

Parentheses ... : Sets the quotes and parentheses recog-
nized by Nisus for the matching parentheses functions. 
Matching parentheses functions are located in the Edit 
Tools submenu under the Tools menu. 

Dictionaries ... : Used to specify default locations of the 
dictionaries. Specifies the dictionary, user dictionary, the­
saurus and hyphenation file locations so that Nisus will 
know where to find them. 

Menu Keys ... : Enables you to set and remove command 
keys from menus, submenus and most pop-up menus. 

Revert 
Start Up ... 
Saving Flies ... 
Editing .. , 
Searching .. . 
Scrolling .. . 
Measurement ... 
Printing ... 
Parentheses ... 
Dictionaries .. . 
Menu Keys .. . 

Other Preferences Found In Other Menus 
Line# Prefs ... : Sets attributes of the line numbers. This preference is located 
in the Display submenu under the Tools menu. 

Set Date & Page # Formats: Changes the manner in which date and ·~ 
page number variables are displayed for individual documents. Also sets the 
starting page number. This preference is located in the Format menu. Time 1 
is set in the Control Panel under the CApple menu. 

Layout Page ... 
Previews the set up of your document. Controls parameters: margins, columns 
and page l~ut. The Layout Page may also be accesse~ by clicking ~n the ~yout 
Page icon l[lli in the scroll bar. A document may be viewed and edited with the 
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- ( 
LayL. Page next to it by clicking on the side-by-side icon~ in the Layout Page 
scroll bar. A new menu called Layout appears when in the Layout Page mode. 

Center: Centers the margins already set. There is also a Center icon Iii! j in 
the Layout Page info bar. 

Expand: Expands the margins to the printer limits. There is also an Expand 

icon /E9.iJI in the Layout Page info bar. 

Set Margins ... : Calls up a dialog box allowing you to set margins, number 
of columns and column gutter width. 

Set Options ... : Sets options for margins, margin distances, margins for 
facing and 2-up pages and graphics limits. 

Set Frame ... : Sets the style and line weight of an optional 
page border. 

Set Columns ... : Sets the number of columns, column 
gutter width, and the line weight and length of an optional 
vertical line between columns. 

Page Setup ... 

Center 
EHpand 
Set Margins ... 

Set Options ... 
set Frame ... 
Set Columns ... 

Sets paper size, orientation and position, the starting page number, options for 
printer effects, footnote placing, and the option for printing crop marks. Laser­
Writer: font substitution, text smoothing, graphics smoothing and faster bitmap 
printing. ImageWriter: tall adjusted, 50% reduction, no gaps between pages. 

Print ... 
Calls up the Print dialog. Sets the number of copies, page numbers, paper source 
and page range (as numbered in document, odd & even, odd only, even only). 
Also gives the option for. updating Cross References and Time & Date. 

Print All 
@Pti3 Print .... Prints all open documents. 

Merge ... 
Mail merge. Allows a main (letter) document to be merged with another which 
contains defined fields, for form letters. 

Transfer ... 
Transforms the Catalog into a list of applications and folders which may be 
opened. It is an easy way to change to a different application without the use of 
MultiFinder. Quits Nisus. 

Quit 
Closes all files and quits Nisus. 
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================( ==================== Ed it Menu 

Undo 
If you make a mistake in your document, this command 
enables you to undo your last action, and the one before, 
and the one before ... until the end of your undo list. The 
number of undos in your undo list depends upon what 
was set in the Editing ... dialog found in the Prefer­
ences submenu under the File menu. The higher the 
number, the more memory is used. The default setting 
is 300 and the maximum is 32,767. 

Clear Undos ... 
@Fl Undo. Clears the Undo list. This allows you to 
free up memory if you are running low. 

Redo 
Redoes your last undo, and the one before, and the one 
before ... until there is nothing left to redo. If, however, 
you edit the document (for instance by typing, deleting, 
etc.), the redo list will be cleared. 

Cut 

Edit Menu 

Undo xz 
Redo 

Cut XH 
Copy xc 
PtUte XU 
Clear 
Select Rll XR 

UPPERCRSE 
lowercase 
Capitalize 
Moue Lert 
Moue Right 
Sort 'I 
Break Lines 
Zap Gremlins 

Show Clipboard xsc 
Set Clipboard (0) ~ 

Cuts the selection to the current Clipboard, erasing anything already there. The 
selection will not remain in your document. 

Append Cut 
(Shift) Cut. Cuts the selection and adds it to what is in the current Clipboard. 
The selection will not remain in your document. 

Copy 
Copies the selection to the current Clipboard, erasing anything already there. The 
selection copied will also remain in the document. 

Append Copy 
(Shift) Copy. Copies the selection and adds it to what is in the current Clipboard. 
The selection copied will also remain in your document. 

Clear Clipboards ... 
@Fl Copy.Clears all Clipboards. 
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.. 

( 

UPPERCRSE 
I Toggle Case I 
Capitalize 
Left I Space 
Right I Space 
or +spaces 

Break Ines+ 
ap remlln• 

---------
Show Cllpbo11rd 
Set Cllpbo11rd (0) 

1) Shift 

Paste 

xz 

XK 
xc 
XU 

XR 

~ 

Modified Edit Menu 

2 
Clear Undos... "i:XZ 
Redo 
Cut ICK 

fClear Clipboards ... f XC 
Pasta XU 
Clear 

fSelect Rll Docs I ICR 

UPPERCASE 

Show Cllpbo11rd 
Set Clipboard (0) ~ 

2) Option 

3 

XR 

Show Cllpbonrd 
SetCJJpboard(O) ~ 

3) Shift-Option 

Inserts the contents of the current Clipboard into your document. When on the 
Text sheet it will paste at the insertion point. When on the Graphics sheets it will 
paste a graphic as a movable object. To paste text copied from the text sheet onto 
the Graphics sheets, click on the Text tool [TI and then click in your document. 
The text will paste in a text box with the current text attributes. 

Swap Paste 
(Shift) Paste. This swaps the selection with whatever is on the current Clipboard. 
The selection is cut to the current Clipboard while the contents of the current 
Clipboard are pasted into the document in place of the selection. On the graphics 
sheets, this pastes whatever is on your clipboard as a PICT. 

Clear 
Clears the selection but does not place it in a Clipboard. 

Select All 
When on the Text sheet, all text is selected. When on the Graphics sheets, all 
graphics with the current attachment attribute (Fix To Page or Move with 'II) are 
selected. · 

Select All Docs 
(option) Select All. Acts as Select All for all open documents. For all documents 
open on the Text sheet, all text is selected. For all documents open on the Graphics 
sheets, all graphics with the current attachment attributes (Fix To Page or Move 
with 'JI ) .1re selected. 
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UPPERCASE 1-
1 Changes all selected te>-. •• o uppercase characters. 

lowercase 
Changes all selected text to lowercase characters. 

Toggle Case 
(Shift) lowercase. Reverses the case of all selected text. Lowercase becomes 
uppercase and uppercase becomes lowercase. 

Capitalize 
Affects the first letter in the selection and in all words selected, making them 
uppercase. 

Move Left 
Moves the first line of a selected paragraph {defined by a return) to the previous 
tab. Moue Left un-indents the first line of a paragraph. 

Move Right 
Moves the first line of a selected paragraph {defined by a return) to the next tab. 
Moue Right indents first the line ofa paragraph. 

Left 1 Space 
(Shift) Moue Le ft. Moves the first line of a selected paragraph {defined by a 
return) one space to the left. 

Right 1 Space 
(Shift) Moue Right. Moves the first line of a selected paragraph {defined by a 
return) one space to the right~ 

Sort~ 
Arranges paragraphs in alphabetical or numerical order. This is particularly useful 
for lists. Note: paragraphs end with a return character. 

Sort + Spaces 
[Shift) Sort en. Arranges paragraphs in alphabetical or numerical order, including 
Returns and non-displayable characters. 

ASCII Sort 
(Option) Sort en. Arranges paragraphs in ASCII order, numerals first, then up­
percase characters, then lowercase characters. 

B EDIT MENU 

ASf " + Spaces 
(Shift) t 6Pti0il) So rt en. Arranges paragraphs in ASCII order, including Returns 

;:::~7;:::ble characters. .A 
Places a return character at the end of each wrapped line, turning·e:~iinto a 
paragraph. · ;· \ .t;·: ·. • 

~ .''i 1,. . ' • 

' ... 1 •. 

Break Lines + . . 
(Shift) Break Lines. Places a return character at the end of each mapped line 
and paragraph. This turns each line into a paragraph and adds a blank line after 
every paragraph already there. 

Zap Gremlins 
Characters produced using the Control or Option keys are deleted when choosing 
this command. This gets rid of all non-displayable characters that are not part of 

the text. Be careful, though. You may need some of the control 
mmm!JI!llill'al"I or option characters {such as the bullet and forced page break) 

... o 
1 

in your document. 

Show Clipboard 
2 
3 .. 
5 
6 
7 
8 
9 

Shows the current Clipboard and allows you to edit its contents.· 
To change the Clipboard you are viewing without l~aving 
the window, simply choose the desired Clipboard from the 
Set Clipboard submenu under the Edit menu. 

Set Clipboard (#} 
Sets the current clipboard. The number in the parenthe­
ses is the number of the current Clipboard. The current 
Clipboard will have a checkmark ../ before it. When 
the Clipboard is showing, you may access this submenu 
without entering the Edit menu. Hold down (Option) 
and click anywhere on the Clipboard window title bar. 
The Set Clipboard ( #) submenu will pop down from 
the title bar wherever you click. 
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Set Clipboard ( #) 
In Tltle Bar 

._oaa CllPIM>ard o -01 
l ... o 8 

I 
2 
3 
4 
s 
6 
7 
8 

...!.. 

Optior:i 
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================~{ ----Tools Menu 

Find/Replace ... 
Calls up the Find/Replace window which includes three 
Find modes: Normal Search, PowerSearch and Power­
Search+; and two Replace modes: Replace and Index (may 
be used for Index As). This window also includes six new 
menus specific to the Find/Replace PowerSearch func­
tions. When in the Find/Replace window, a new menu 
called Search Method appears to the right of Style. 

Find Next 
(Shift) Find/Replace .... Finds the next occurrence of 
the text in the Find box without bringing the Find/Replace 
window to the front. 

Find All 

Tools Menu 

find/Replace... Xf 
Copy to find 
Mork TeHt ... 
Jump To ._ 
Crou Reference ... 
Update H-Reference 

Spelling ... 
Thesaurus ... 
Hyphennte 

Pince Poge ... 
Place New Page 
Glossary ._ 
Edit Tools ._ 
DI splay .. 
Windows ._ 
Macros .. 

Option) FI n d IR e p I ace •.•• Finds all occurrences of the text in the Find box and 
;elects them noncontiguously without bringing the Find/Replace window to the 
iont. 

Find in Selection 
: Shift )@Pt§) Fl n d IR e p I ace .... Finds all of the text in the Find box and selects 
lt noncontiguously within the text selected in the document, without bringing the 
rind/Replace window to the front. 

Replace 
X Command) Find/Replace .... Replaces selected text with whatever is in the 

\eplace box without bringing the Find/Replace window to the front. 

~eplace & Find 
X Command I( Shift) Find/Replace .... Replaces a selection of text with whatever 
s in the Replace box, and then finds the next occurrence of the text in the Find 
)()X, without bringing the Find/Replace window to the front. 

~eplace in Selection 
x Command) (O'PtiOfi) Find/Replace .... Replaces all of the text in the Find 

>OX with whatever is in the Replace box within the text selected in the document, 
vithout bringing the Find/Replace window to the front. 
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Modified Tools Menu ( ' 
~~~~~~~~~~~~~~~~~~~~~~~~~~~-

2 3 
find NeHt Xf 
Cop to Replace 
Mark TeHt ... 
Jump To ~ 
Remoue H-Reference 
Updn le H-Reference 

Spelling ... 
Thesaurus ... 
Hyphenate 

--------
Place Page ... 
Place New Page 
Glossary .. 
Edit Tools .. 
Dlsplny .. 
Windows .. 
Macros .. 

1) Shift 

5 

""""~.:.....,__~~ Xf 

Spelling ... 
The1ouru1 ... 
Hyphenate 

Place Page ... 
Pince New Page 
Glossary .. 
Edit Tools .. 
DI splay .. 
Windows .. 
Macros .. 

2) Option 

Cop to Replace 
Marie TeHt ... 
Jump To .. 
Remoue H-Reference 
Update H-Reference 

Spelling ... 
Thesaurus ... 
Hyphenate 

Spelllng ... 
Thesaurus ... 
Hyphenate 

Place Page ... 

Remoue H-Reference 
Update H-Reference 

Spelling ... 
Thesaurus ... 
Hyphenate 

Place Page ... 
Place New Page 
Glossary >-
Edit Tools ._ 
Dlsplay >' 
Windows >-
Macros >-

3) Shift-Option 

.. 
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Spelllng ... 
Thesaurus ... 
Hyphenate 

Pince Page ... 
Place New Page 
Glossary ._ 
Edit Tools >-
Dlsplay >-
Windows ._ 
Macros .. 

4) 3€ Command 

Remoue H-Reference 
Update H-Reference 

Spelllng ... 
Theuurus ... 
Hyphenate 

Place Page ... Pince Page ... 
Pince New Page Pince New Page Pince New Page 
Glossary .. 
Edit Tools >-
Dlsplay >-
Windows >-
Macros >-

5) 3€ Command­
Shift 

Replace All 

Glossary .. 
Edit Tools .. 
Dis play .. 
Windows .. 
Macros .. 

6) 3€Command­
Option 

61osury .. 
Edit Tools .. 
Dis play .. 
Windows .. 
Macros .. 

7) 3€ Command­
Shift-Option 

[ ~ Command ) (Shift ) (O'PtiOfi) FI n d IR e p I ace .... Replaces all occurrences of the 
text in the Find box with whatever is in the Replace box without bringing the 
Find/Replace window to the front. 
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Find/Replace Wjndow Menus 
Menus accessible withll .e Find/Replace window in the PowerSearch mode. 

12 

Wild Card: Contains metacharacters, which are used as wild cards. Wild 
cards match a range or collection of characters: 

Any character: Matches any character except return. 

Any character or 11: Matches any character including a return. 

A·Z a-z: Matches any alphabetic character or underline. That is, any 
letter A through Z, a through z, or_. 

A·Z a-z 0-9: Matches any alphanumeric or underline. 

Rny character 
Rny character or 'I 
R-Z a-z 

That is, any digits 0 through 9, any letter A through Z, a 
through z, or_. 

0-9: Matches any digit 0 through 9. R-Z a-z 0-9 
0-9 
11-z 
R-Z 

a-z: Matches any lowercase letter a through z. 

Spoce or Tob A-Z: Matches any uppercase character A through Z. 

Space or Tab: Matches either a space or tab character. 

Special: Contains the OR metacharacter used to designate alternatives, 
along with the white space metacharacters: 

OR: Allows you to specify alternatives in your pattern. 

11: Matches a return character. 

Space: Matches a space character. 

Tab: Matches a tab character. 

Page Break: Matches an explicit (forced) page break. 

OR 

'I 
Spoce 
Tob 
P~e Breok 

Repeat #: When chosen, these items indicate that the previous character in 
the pattern is to occur the following # of times: 

O+: The previous character may occur zero or any number of times. 

1 +:The previous character may occur one or any number of times. 

O or 1: The previous character may occur zero or one time. 

Position: Affects the position of the insertion point, 
rather than the text. Any replacement text will be put 
at the insertion point's new position. 

Character On Left: A match is found for the char­
acter following this item. The insertion point is 
moved to the right of that character. 

. , 
Ch11r11cter On Left: 
Ch11r11cter On Right: 

Word Stort 
line stort 
'I Stort 
Document Stort 
Word End 
'I End 
Document End 

TOOLS MENU 

~haracter On Right: A match is found for the character followini- ~s 
item. The insertion point is moved to the left of that character. 

Word Start:Moves insertion point to the beginning of the next word. 

Line Start: Moves insertion point to the beginning of the next line. 

11 Start: Moves insertion point to the beginning of the next paragraph. 

Document Start: Moves insertion point to the beginning of the document. 

Word End: Moves insertion point to the end of the next word. 

11 End: Moves insertion point to the end of the next paragraph. 

Document End: Moves insertion point to the end of the document. 

Clipboard: Used in the replacement pattern, not the find 
pattern. Refers to the text or graphic last copied into the cor­
responding Clipboard. 

••IJllJ I :il1!.m 
Current 
#0 

Match: Contains the phrases which deal with matching pat­
terns and expressions. 

Found: Matches the last found and selected expression. 
Used in the replacement pattern, not the find pattern. 

#1 
#2 
#3 
#4 
#5 
#6 
#7 
#8 
#9 

( ... found 1) 
( ... Found 2) 

(: Left Parenthesis. Only useful in constructing find patterns. In 
PowerSearch, text matched by the parenthesized expression is 
remembered and can be later referred to as expressions one 
through nine. Used with ) (Right Parenthesis). 

): Right Parenthesis. See ( (Left Parenthesis) above. ( ... round 3) 
( ... Found 4) 
( ... found 5) 
( ... found 6) 
( ... round 7) 
( ... found O) 
( ... Found 9) 

( ... Found 1) through ( ... Found 9): Matches whatever each of the 
parenthesized expressions define. Helps to simplify the pattern 
for finding and replacing. 

Search Method 
This menu appears to the right of the Style menu when the Find/Replace window 
is open and in front. 

Find Text Only: Searches for text without regard to attributes, and searches 
for any graphic rather than a particular one . 

. Replace Text Only: Replaced text takes on the same 
attributes (font, size, style) as the first character of the 
found text. If a graphic is part of the replacement pattern, 
the ASCII code 01 will show in place of the graphic. 

Search Active File: Searches the front (current) file. 

Search All Open: Searches all open files. 
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.,...find Teut Only 
.,...Reploce Teut Only 

.,...seorch Rct111e Fiie 
seorch 1111 Open 
Seorch Fiie list 
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Search Fiie List:( 1.rches files in the search list. This can only be used 
when a search list has been created. To create a search list, choose Catalog ... 
from the File menu, select the file names in the Catalog, and choose Add To 
Search List. Files in the search list are preceded by an eye icon~. 

:opy to Find 
~nters selected text directly into the Find box without bringing the Find/Replace 
Alindow to the front. This automatically turns on the Find TeHt Only command 
n the Search Method menu. 

Copy to Replace 
Shift} Copy to Find. Enters selected text directly into the Replace box without 
)ringing the Find/Replace window to the front. This automatically turns on the 
qeplace TeHt Only command in the Search Method menu. 

1Vlark Text. .. 
)ets or deletes a marker. To set a marker, select the text or place the insertion 
)Oint at the position you wish to mark. Then choose Mark TeHt .... You then 
1ame the marker and click on Set. To delete a marker, choose Mark Te Ht ... , 
hen choose the marker name you wish to delete from the Jump To submenu, 
md click on Delete. Markers are listed at the bottom of the Jump To submenu. 

I lJ 
Page .. , 
line ... 

Marker 1 
Marker 2 
Marker 3 

Jump To 
Allows you to move around your document without the use of 
scroll bars. It moves the insertion point to a specific line, page, or 
marker. Choose Line ... , Page ... , or the marker name from the 
Jump To submenu in the Tools menu. Type the pa e or line 
number into the box of the dialog and click OK (or press Return ). 

:ross Reference ... 
.rus is used when you want to refer something to a particular page, line, paragraph, 
lr marked text. Text to be Cross Referenced must be marked first, using the 
'1ark TeHt ... command in the Tools menu. 

R.emove X-Reference 
Shift) Cross Reference .... Removes all Cross Reference links within the selec­
ion. Cross References to marked text becomes unlinked so that the text is editable. 
::::ross References to page, line, page line, or paragraph numbers become the 
:urrent page, line, page line, or paragraph number of the reference itself. 

Update X-Reference 
Updates all Cross Referenced text. This is necessary when text has been edited 
md Cross References have been used. 
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Sp( ing ... 
Brings up the Spell Checking window. The document to be edited must be open. 
If you click on Start Checking, it will check everything, starting from the 
insertion point. To check a word, type it in the box and click on Check Word. 

Thesaurus ... 
Brings up the Thesaurus dialog. You may either select a word from your document 
to look up, or type in a word. It will give you the part of speech, the definition, 
synonyms and antonyms for that definition. To replace a selected word in your 
document, double-click on the synonym or antonym. 

Hyphenate 
Hyphenates all selected text, if the Nisus Hyphenation file is present. To unhy­
phenate a particular word or section, select it and choose Hyphenate again. 

Place Page ... 
Calls up the Place Page dialog. Select the document you wish to place and click 
on Place. On the text sheet, the document is placed at the insertion point as a 
character graphic. You may crop and resize this just as you would any character 
graphic. On the graphics sheets, you may treat it as any other complex graphic. A 
Placed Page document, on any sheet, may be edited directly by double-clicking 
on the placed page graphic. 

Place New Page 
Places a document box which says: "Resize and double-click this box to edit." 
The new document opens to this size. If you want this to be editable, you will 
need to save the new document. After you have placed the new page this way, it 
will act the same as a placed page graphic from PI ace Page .... 

Glossary 
A submenu for editing glossary files. A glossary file contains user defined ab­
breviations which expand into user defined text and graphics. This simplifies the 
typing or pasting of commonly used phrases, names, graphics, etc. Glossary 
abbreviations are listed at the bottom of the Glossary submenu. 

Expand Abbrev.: Expands the abbreviation _to the 
left of the insertion point, or in the selected text. Ab­
breviations are defined by your Glossary definitions. 

Edit Glossary: Accesses a new Glossary or the cur­
rent one (if one exists). This allows you to start a 
Glossary or edit entries already in the current glossary. 

New Glossary Entry ... : Accesses the Glossary and 
allows you to add another entry. 

GIO\\dllj • 

EHpand Rbbre11. X\ 
Edit 61ossary 
New Glossary Entry ... 
New Glossary ... 

ebbre11.I 
abbre11.2 
ebbre11.3 

New Glossary ... : Allows you to form a new Glossary. You may have more 
than one Glossary, but only one can be used at a time. 
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Edit Tools ( 
Submenu for comparisons between two files, quotes and 
parentheses, and accessing the ASCII Table. 

ld1t Tool~ • 
Compare 
Sync. Scrolllng 
Balance 0 
Recount() 
ASCII Tobie ... 

Compare: Checks two open files for differences. The 
insertion point jumps to the first difference. 

Compare (no spaces): (Shift) Compare. Checks 
two open files for differences not including multiple blank 

Modified Edit Tools characters. The insertion point jumps to the first difference. 
Submenu . 

, .m ll 
(Comporelno spocel) 
sync.scrOllTng 
Bolonce () 
Recount() 
ASCII Tobie ... 

Shift 

Sync. Scrolling: Synchronous scrolling allows you to 
scroll two open files at the same rate and time. 

Balance ():Allows you to select the closest set of matching 
parentheses on either side of the insertion point. Place the 
insertion point inside the matching parentheses and choose 
Balance ( ) from the Edit Tools submenu. The paren­
theses and everything inside them will become selected. 

Recount ( ): The information bar displays unbalanced parentheses in the 
right comer when Check Parentheses is set in the Parentheses preferences. 
This function updates that display when text is cut or pasted, or when the 
display is first turned on. 

ASCII Table ... : This displays the ASCII codes for all characters in any font 
in your system. You can double-click on a character or symbol to enter it into 
your document at the insertion point, or use copy and paste. In this way you 
may use hard-to-find characters that are necessary for your document. It also 
enables you to find out the ASCII code for a particular character. 

Display 
Submenu allowing you to display various things which are otherwise hidden. 
The checked../ items are on display. 

Document: Checked when in the Document window. Select 

.1Document 
Headers/Footers 
Footnotes 

this to return to the Document window when in the Head­
ers/Footers or Footnotes windows. 

Headers/Footers: Select this to open the Headers/Footers 
window, if any headers or footers are present in the document. Line# Preh ... 

Line Numbers 
Spece, Tab & 'I 

.1TeHt Hllltes 
lnulslble TeHI 

.1Poglnotlon 
Graphics As II 
As Postscript'" 
Graphic Anchors 

Uertlcol Ruler 
.llnfo Ber 
.1Moster Ruler 

Graphics Palette 
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Footnotes: Select this to open the Footnotes window, if 
any footnotes are present in the document. 

Line# Prefs ... : Sets attributes, font, size, style and number­
ing pattern of the line numbers. 

Line Numbers: When checked, the line numbers appear 
on your document as specified in Line # Prefs .... 

Space, Tab & 1[: Puts a symbol for every space, tab, return 
and forced page break. This is useful for editing purposes. 

TOOLS MENU 

'1'.'ext Hllltes: Highlights all Variable text (time, date, cross referencr 'tc.), 
.ark Index text, Index As ... text and Mark Contents text, with a dottL , . .'.'.'.'.'.'.! 

or dashed C::J box around each item. 

Invisible Text: Makes all Invisible Style text visible. A variable box shows 
around it if Te Ht Hllites is on. If printed while I nulsible Te Ht is checked, 
Invisible text will print. This does not change the fact that it is in Invisible. 
Choosing I nuisible Te Ht a second time will return it to its invisible state. 

Pagination: Displays page breaks. When this is not checked, page breaks 
are turned off and not acknowledged, displaying the document as one con­
tinuous page. (Graphics with the Text Wrap On attribute are not displayed 
as such when Pagination is turned off.). 

Graphics As X: Displays and prints graphics as a box with an X inside, for 
faster scrolling and printing while editing a document. 

As Postscript®: Displays all graphics as they will print using a PostScript 
printer. 

Graphic Anchors: Displays symbols to show where each graphic is attached. 
The symbol for a graphic which flows with a paragraph is a dashed line 
······.extending from the graphic to the beginning of the paragraph to which 
it is attached. The symbol for a graphic attached to a page is a miniature page 
icon D. attached to the left comer of the graphic. 

Vertical Ruler: Shows a ruler extending vertically on the left side of the 
document window. The Vertical Ruler may also be accessed from the Vertical 
Ruler icon !DJ on the left of the horizontal scroll bar. 

Info Bar: Located above the ruler. Shows the on-screen page/column num­
ber(s), the insertion point placement, the Change Indicator icon .JJ and the 
Synchronized Scrolling icon M . The Info Bar may also be accessed from the 
Info Bar icon[!] in the scroll bar. 

Master Ruler: Shows margins, displays indents and tabs, line and paragraph 
spacing and paragraph justification for the current paragraph. The Master 
Ruler may also be accessed from the Master Ruler icon§ in the scroll bar. 

Graphics Palette: Puts you on the Graphics sheets, where graphics are 
created or pasted as objects or PICT's. Contains a graphics toolbox with 
patterns. Controls whether graphics wrap-around text or overlap, whether 
they are in front of or behind the text, and whether they attach to the page or 
flow with a paragraph. The Graphics Palette may also be accessed from the 
Graphics Palette icon [lliJ in the scroll bar . 

Windows 
Submenu containing Nisus window controls, for use when 
multiple Nisus windows are open. You may also access 
this submenu without entering the Tools menu. The Win­
dows submenu will pop down from the title bar when 
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Send Bock IC• 
Toggle Front 2 

Stack 
Tiie 

.PUntltled-1 
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you hold down CE§:ry · '~ and click anywhere on 
a Nisus window title bal'. This works on all Nisus 
windows except the Macros window. 

Unlltled-1 =:101 
X• 

Send Back: Sends the active window back behind 
all other open windows. 

Toggle Front 2: Brings the 
Modified Windows window behind the active win-

Untitled-I 

Submenu dow to the front. 3€ Command 

• I 
Stack: Arranges all windows in an orderly fashion, one 
on top of the other, so that all title bars are in view. Send Back 

Toggle Front 2 

Stack 
!Tiie Front 21 

X• 

Tiie: Fits all open windows into the available screen space 
without overlapping them. 

[Puntllled-1 Tiie Front 2: [Shift) Tile. Fits the front two document 
windows into the available screen space without overlap­
ping them. Shift 

Macto• Macros Record 

Allows you to make, edit and write macros, which make 
repetitive or complex tasks very simple. You may access the 
Macro List part of this submenu without entering the Too Is 
menu. Hold down (Option) and click anywhere on a Nisus 

Edit Macro ... 
EHecute Selection 
New Macro ... 
New Fiie ... 

window title bar. The Macro List from the Macros submenu will pop down 
from the title bar wherever you click. This works on the Document, Catalog, 
Find/Replace, Footnotes, Headers/Footers and Macros windows. 

Record: Records every step made, key or mouse click, into a Macro file. 
Perform the actions you wish to record, and when you are finished, choose 
stop Recording .. .. 
Stop Recording ... : Shown in place of Record dm:ing recording. Choosing 
it halts the recording and calls up the Macro Name dialog. 

Edit Macro ... : Opens the current macro file. You can then scroll to the 
macro you wish to edit. 
Execute Selectlon: Used to test each macro instruction. Select the text in 
the macro file and choose EH e cute Se I e ct Ion. This can also be used to test 

macro-like text in a document as if it were a macro. 

Macro List In TI tie Bar New Macro ... : Calls up the Macro Name dialog. After 

Option 

18 

you give your new macro a name, the Macro file will 
open with a space ready for you to type in a series of 
instructions. 
New Fiie ... : Closes the current Macro file and creates 
a new, empty macro file. This should not be confused 
with the New Macro ... command. 
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--( --, =============================Macro Fi k 3 

~ 1t1•pomlmenl Mell 1 o• 

Appointment Macros 
• Appointment Cnlendnr 
• Rppolntment Summary 

Macros which deal with organizing a personal calendar 
of appointments. Do not use the files which do not have 
a bullet in front of the name. They are necessary for the 
bulleted macros to function. 

•Appointment Calendar: Creates an appointment 
calendar. 

•Appointment Summary: Creates a summary of 

• Make Rppolntment 
Copu Pince 
Copy Soft Return 
Copy Subject 
Copy Time 
Copy With 
create St11tlonery 
flH D11te 
Get Month Rnd Ye11r 
Make Summa 

all appointments entered using the •Make Appointment macro. 

•Make Appointment: Creates an appointment file for a specific day, month 
and year. Each appointment will appear in the calendar and summary. 

Copy Place: Called upon in the main Appointment macros. 

Copy Soft Return: Called upon in the main Appointment macros. 

Copy Subject: Called upon in the main Appointment macros. 

Copy Time: Called upon in the main Appointment macros. 

Copy With: Called upon in the main Appointment macros. 

Create Stationery: Called upon in the main Appointment macros. 

Fix Date: Called upon in the main Appointment macros. 

Get Month And Year: Called upon in the main Appointment macros. 

Make Summary: Called upon in the main Appointment macros. 

Macros For Creating 
Macros which deal with creating, converting, copying and printing. 

•Symbols: Used for copying symbols when making new macros. Left/right 
arrow, command/shift/ option modifiers, delete key. 

Add: Adds a selected column of numbers. Places result at bottom of column. 

Address List •.• : Copies a list of addresses from any file, from the insertion 
point to the end of the file. 

Calculate Selection: Evaluates the selected expression. 

Convert·> Database: Merges all fields of a record by replacing the return 
characters with commas and each address will be in a separate paragraph. 

Convert<· Database: Converts from a database format to one with each 
field in one paragraph. The database format assumes that each record is on 
one paragraph and fields are separated by commas. 

NISUS MENU REFERENCE 19 

•• 



20 

Convert MSW 1( )X: Converts Microsoft Word indexed entries into Nisus 
indexed selections. 

Convert MSW ToC: Converts Microsoft Word contents entries into Nisus 
contents selections. 

Copy Pathname: This macro copies the full pathname of the current 
document onto the Clipboard. 

Count Paragraphs: This counts the number of paragraphs in the active 
window by counting the number of return characters that are preceded by a 
character other than return. 

Count Sentences: This counts the number of sentence breaks, which are 
considered to be punctuation marks (., !, and?). 

Count Words: This macro counts the number of words in the document by 
replacing every word with itself. 

Create Directory: This macro creates a directory by the name given in the 
current selection then displays that empty directory in the Catalog. 

Create Macro: Takes the text of a set of macros in the current document 
beginning at the insertion point, and adds these macros to the current macro 
file. 

Create Word List: This macro removes all duplicate words from a document 
and sorts the remaining words. Case is significant. Creates a new document. 

Extract Phone List: Extracts names and phone numbers ~om a?dresses 
arbitrarily placed in files. Creates a list of names together with their phone 
numbers. 

Extract References ... : Searches the current file for all references to a user 
defined key phrase. The references are placed in a file with the name of "Ref 
<current time and date>." 

Get Addresses: Finds all addresses of the form described in the macro 
Find Address and copies them to Clipboard 9. 

Get Phone Num: Scans the current file, generating a list of names together 
with their phone numbers. Phone numbers are appended to Oipboard 9. 

Get Ref: Searches the current file for all references to the key word specified 
in Clipboard 9. The references are placed in Clipboard 8. 

lnltNew <Inactive>: The purpose of this macro is to demonstrate the InitNew 
feature. 

Insert My Ruler: Pastes the ruler, which is attached to the carriage return 
between the second set of double quotes of the Paste command. 

Ligatures: This macro substitutes fi and fl in standard LaserWriter fonts 
with their equivalent ligatures. 
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, 
( ( 
l\ ... me:flle>folder: Finds the first proper name at the top of a letter with 
any personal title that precedes it. It will then name the file with what it has 
found and place the file in a folder with that same name. 

New Folder ... : Prompts for a folder name and then creates a new folder by 
that name in the current directory. 

Print Envelope: This macro prints an envelope with a return address. 

Print NRA Envelope: Prints a "No Return Address" envelope. 

Print with Ligatures: This macro replaces "fi" and "fl" by their equivalent 
ligatures and prints the entire document. 

Restore Search List: Restores the search list. Needs the marker "Select 
RSL macro" in order to work. 

Save Search List: Writes the Restore Search List macro, so that it will 
restore the search list in the Catalog when called. 

Macros For Editing 
Macros which perform editing functions. 

Assign Marker: Assigns the selected text to the name of a marker, which 
marks the selection. 

Capitalize Sentences: Capitalizes the beginning of each sentence. 

Clear Current Clipboard: Clears the current clipboard. 

CommandOptlon: This macro will put smart "quotes" around any selected 
text. It executes automatically when both the command and option keys are 
pressed while you double-click on that text. 

End of Sentence: Moves the insertion point to the end of the next sentence. 

Form Paragraph: Does the opposite of the Break Lines command. It forms 
one paragraph out of the selected paragraphs by replacing any intervening 
return character with a space. 

Lower Subscripts: Changes all digits which follow an alphabetic within 
the selection to the Subscript style. Useful for writing equations. 

NSpaces To Tab ... : Converts groups of spaces at the beginning of a 
paragraph to tabs. 

Number Bullets: Converts all bullets "•"at beginning of paragraphs in 
the selection to numbers. If there is no selection, it affects the whole document. 

Option: Capitalizes the word under the insertion point when you hold the 
Option key while double-clicking. 

Plain Numbers: Changes all the digits which follow an alphabetic within 
the selection to the Plain style. 
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Quote: Inserts opl ~\g quote if the insertion point follows a space, tab or 
return. Inserts closing quote if the insertion point follows any other character. 

Raise Powers: Changes all digits which follow an alphabetic within the 
selection to the Superscript style. Useful for writing equations. 

Renumber: Renumbers all numbers in selected region, starting with 1. If 
there is no selection, this is done from insertion point to end of the document. 

Renumber ~: Renumbers those paragraphs which already begin with a 
number. The starting number is the first one it finds after the insertion point. 
It will stop when it gets to the end of the document. 

Remove Blank Lines: Removes all blank lines in the document. 

Remove Keep on Same Page: Removes any Keep On Same Page attribute 
from all text in the document. 

Remove Page Breaks: Removes all forced page breaks. 

Remove Repeated~: Makes sure no groups of repeated paragraphs are 
in the current document. It will remove repeated lines of text. 

Remove Trailing Blanks: Removes all spaces and tabs at the ends of 
paragraphs. 

Select First 2 Lines of~: Selects the first two lines of the next paragraph 
(searching forward). 

Select Last 2 Lines of ~: Selects the last two lines of the previous 
paragraph (searching backward). 

Smart Quotes: Replaces all single and double quotes with smart quotes, 
unless they refer to measures as in feet and inches. 

Spaces To Tab: Converts spaces at the beginning of a paragraph to a tab. 

Straight Quotes: Replaces all single and double smart quotes with single 
and double straight quotes, respectively. 

Unbreak Allnk Lines: Removes all blanks at the beginnings of paragraphs, 
then removes all returns not preceded by a return or an end of sentence or a 
colon. Works well for AppleLink messages. 

Unbreak Lines: To unbreak lines in the selection only. It also replaces any 
sequence of three or more spaces with one tab. 

Unhyphenate Proper Name: Finds e_very capitalized word and removes 
it from Hyphenate. 

Widow & Orphan Control: Keeps the first two and last two lines of 
paragraphs together on the same page. 

Zap Control Chars: Removes all Control characters (except Return). 

Zip Code Order: Orders a document of addresses by zip code. 
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Mac~ J For Indexing 
Macros perform with indexing functions. 

Merge Indexes: Merges two indexes together. 

Sub Index: Converts multiple entries of the same heading in an index file 
to subindexes of the heading. 

Macros For Locating 
Macros which perform searching and Find/Replace functions. 

Capitalize Sentence: Finds the beginning of a sentence (the space following 
any word with a period). 

Copy Open Pathnames: Copies the full pathnames of all open documents 
onto the Clipboard. 

Copy Pathname: Copies full pathname of current document to Clipboard. 

Copy Search List Pathnames: Places the full pathnames of all the files 
on the search list in the Catalog on the current Clipboard. 

Copy Subject Pathnames ... : Prompts user for a subject name then looks 
throug~ the search ~st files for that subject. If a file containing subject is 
found, Its pathname Is appended onto the clipboard and the search continues. 

End of Sentence: Moves the insertion point to the end of the next sentence. 
Find Address: Finds an address. 

Find ASCII Code: Finds the ASCII value of the character selected in the 
front document by finding the character in the ASCII Table window. 

Find Contents Selection: Finds text which is marked with Mark Contents. 

Find Index Selection: Finds the text which is indexed with Mark Index. 

Find Keep on Same Page: Finds text with Keep On Same Page attribute. 

Find Phone Number: Finds the next phone number. 

Find Repeated Word: Searches for repeated words and selects them. 

Next Wrapped Line: Moves the insertion point to the beginning of the 
next wrapped line. 

Macros For Outlining 
Macros which perform outlining functions. Do not use the files which do not 
have .a bullet in front of the name. They are necessary for the bulleted macros to 
function. Because these macros perform specific functions which relate to one 
another, instructions are included, following the last outlining macro. 

•• Begin New Outllne: Creates a new outline. Used on a new document. 

• Add Thought: Adds a new thought at the same level. 

• Beginning Thought: Adds a new thought at the top level. 
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--------, ( ~ollapse All: Collapses every thought, at all levels. 
,,..Mactos rm outlmlnq 
•• Begin New outline 
• Add Thought 
•Beginning Thought 
•Collapse All 
• Collapse All + 
• Collapse Thought 
•Collapse Thought+ 
•Demote Thought 
• EHpand All 
• EHpand Thought 
• EHpand Thought • 
• Go To Bottom 
•Go To End 
•Go To End + 
• Go To Start 
•Go To Top 
• Number outllne 
•Paste Thought Rbo1Je 
•Paste Thought Below 
•Promote Thought 
• Reuert To Bullets 
•Select RU 
• Select Outline Numbers 
• Select Thought 
• Select Thought + 
• sub ThOughl 
•Super Thought 
Rdjust Leuel 
Find End or Thought 
Find Finl Thought 
Find Lnsl Thought 
Find Start OfThought 
find To same Leuel 
Prepare Thought 
z1Leu 
z2Leu 
z3Le1J 
z4leu 
z5Leu 
zrrrteu 

• Collapse All+: Collapses every thought to its top 

level. 
• Collapse Thought: Collapses the thought where 
the insertion point is. 
• Collapse Thought+: Collapses the thought and its 
sub thoughts at the insertion point. 
• Demote Thought: Moves the current thought one 

level down. 
• Expand All: Expands the entire outline into view. 

• Expand Thought: Expands the current thought. 

• Expand Thought +: Expands the current thought 
and its sub thoughts. 
•Go To Bottom: Goes to the bottom of the outline. 

•Go To End: Goes to the end of the curre:r;lt thought. 

• Go To End+: Goes to the end of the current thought's 
last sub level. 
• Go To Start: Goes to the start of the current thought. 

•Go To Top: Goes to the top of the outline. 

• Number Outline: Numbers the headings of all the 
thoughts in the outline. 
• Paste Thought Above: Pastes a copied thought 
above current thought. 
• Paste Thought Below: Pastes a copied thought 

below current thought. 
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• Promote Thought: Moves the current thought one level up. 

• Revert To Bullets: Replaces all numbered thoughts with bullets. 

• Select All: Selects the entire outline. 
• Select Outline Numbers: Noncontiguously selects the heading numbers 
of the outline so that you can change the character attributes. 

• Select Thought: Selects the current thought. 
• Select Thought+: Selects the current thought and all its sub thoughts. 

• Sub Thought: Adds a new thought one level down. 

• Super Thought: Adds a new thought one level up. 

Ad}ust Level: Called upon in the main Outlining macros. 

Find End Of Thought: Called upon in the main Outlining macros. 

Find First Thought: Called upon in the main Outlining macros. 
TOOLS MENU 

Find Last Thought: Called upon in the main Outlining macros. 

( . Ind Start Of Thought: Called upon in the main Outlining macros. 

Find To Same Level: Called upon in the main Outlining macros. 

Prepare Thought: Called upon in the main Outlining macros. 

z1 Lev: Called upon in the main Outlining macros. 

z2Lev: Called upon in the main Outlining macros. 

z3Lev: Called upon in the main Outlining macros. 

z4Lev: Called upon in the main Outlining macros. 

zSLev: Called upon in the main Outlining macros. 

zErrlev: Called upon in the main Outlining macros 

Using the Outlining Macros 

Getting Started 

The outlining macros allow you to create an outline anywhere in your 
document. You can have as many separate outlines as you like. To start an 
outline at the insertion point, choose•• Begin New Outline . 

Each element of an outline is called a thought. Thoughts are placed in levels 
beginning with the top level, which is not indented. The bottom level is 
indented the farthest to the right. You can create 5 levels. There are 4 ways to 
add a new thought to your outline: 

1. • Beginning Thought: begins a new thought at the top level. 

2. •Add Thought: begins a new thought at the level of the thought where 
your insertion point is, the current thought. 

3. • Sub Thought: begins a new thought one level down from the current 
thought. 

4. • Super Thought: begins a new thought one level up from the current 
thought . 

If you wish to change the level of a particular thought, place the b:lsertion 
point in the thought and execute either • Promote Thought or• Demote • 
Thought to increase or decrease the level. 

l!Y' Do not use the outlining styles or named rulers directly to reposition a thought's 
level. Always use the promote and demote macros. 
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All macros for outlir · \ purposes are prefixed with a bullet ( • ). The other 
macros, without bull .... .,; are auxiliary macros which are called as subroutines 
from other macros and are not to be run by you directly. 

Outlining macros with a plus sign (+) apply the macro's operation to the 
current thought and all sub levels of the current thought. The macro 
• Collapse Thought +,hides the text of the current thought as well as all 
the text of the current thought's sub thoughts. 

Hiding Thoughts From View 
To hide a thought run one of the Collapse macros. A collapsed thought is 
indicated by the box style placed on the first line of text of the thought. To 
expand a thought, run one of the Expand macros. 

Cutting, Copying and Pasting Thoughts 
Thoughts can be cut, copied, pasted and moved, but you must always 
remember to use the• Select Thought macro to select the entire thought. 
This will guarantee that the rulers are selected properly. 

Once a thought is selected, you can use the Cut, Copy and Clear commands 
of the Edit menu. You should only use the Paste command of the Edit 
menu when you are pasting over another thought that is selected. You can 
also paste a thoughtwith the• Paste Thought Abouear •Paste Thought 
Below macros that will paste a copied thought above or below the current 
thought. 

Numbering the Outline 
Number an outline with the • Number Outline macro. Change the 
font/size/style/color of the outline's numbers by first running the• Select 
Outline Numbers macro and then selecting the new font/size/style/color 
you want to apply from the respective character attribute menus. 

To change the outline numbers to bullets (•),run the• Reuert To Bullets 
macro. 

UY' Running the numbering macros will expose numbers that have been collapsed. This 
is not a bug. To hide the numbers again re-collapse the thoughts. Programmers may 
change the creation of the numbers by modifying the zLev macros. 
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Mo(~ 1g Around 

The. Go To macros are positioning macros for jumping to other places in the 
outline. You can move to the beginning and end of the outline or thought. 

Tips on Using Outlining Macros 

It is possible to have collapsed text that is not shown in box style. To find 
such text choose the command I nuislble TeH t from the Display submenu 
of the Tools menu, or run the• EHpand All macro. 

~ ~utlines are made contiguous by named rulers. If you insert a new ruler 
lev must appear somewhere as a part of its name in order to maintain the 

continuity of the outline. · 

It is.recom~ended that you assign command keys to the outlining macros to 
avoid havmg to select them from the Macros menu. If you must use the 
Macros menu you can quickly access it by clicking on the title bar of the 
document while pressing the Option key. 

Specialized Macros 
Macros which use the Nisus Programming Dialect rather than the Menu Dialect. 

Constants: Global constants that can be used with the calculator. 

Create Calendar: Creates a calendar for a given month and year. 

Diagram Folder Structure: Creates a hierarchical listing of all folders 
names from the current folder displayed in the Catalog window. 

Calculate Line: Evaluates any mathematical expression typed as a line of 
text. Supports all elementary math functions. Places the result on a new line 
below the expression. 

User Dictionary Macros 
Macros which deal with user dictionaries. 

A~~ to User Dictionary: Adds words from a word list to the current User 
Dictionary. 

Make User Dictionary List: Makes a list of all words in current user 
dictionary. 

R.e'!love from User Diet: Removes a list of words from the current user 
dictionary. 
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==================---=======~ Format Menu 

Insert Ruler 
nserts a ruler on the same line as the insertion point, 
f it is at the beginning of the line. Otherwise, a 
·eturn will be added to the right of the insertion 
JOint and the ruler will be inserted on the new line. 

Insert Header/Footer 
lnserts a header or footer and then opens the Head­
=r /Footer window, which can be edited like any 
Jther text window. You may include graphics in 
:he headers and footers. All Headers and Footers 
ire shown in this window. This window has its own 
nenu. To open the Headers/Footers window, choose 
~eaders/Footers from the Display submenu un­

···~,. 

der the Tools menu, or double 
click on a header or footer. 

Format Menu 

IIi 
Insert Ruler 
Insert Header 
Insert Footer 
Insert Footnote 
Insert Page Bre11lc 
Keep On Same Page 

Insert Date 
Insert Time 
Insert Doc Name 
Insert Page # 
Update Time II' Date 
Set Date & Page# Formats ... 

Marie lndeH XE 
lndeH Rs ... 
Make lndeH ... 
Marie Contents XT 
Make Contents ... 

Remoue Header 

"RU Pages 
Odd Pages 
Euen Peges 

Go To Reference 

Remove Header/Footer: Removes a header or footer 
from the document. When the insertion point is in a header 
editing box, the menu will read Remoue Header. When 
the insertion point is in a footer editing box, the menu 
willread Remoue Footer. 

All Pages: Places the header or footer on all pages of the document. 

Odd Pages: Places the header or footer on odd pages of the document. 

Even Pages: Places the header or footer on even pages of the document. 

Go To Reference: Allows you to go to the paragraph to which that particular 
header or footer is attached. 

Insert Footnote 
Ill! IUJI! 

Footnote Symbol .. . 

)pens the Footnote window which can be edited like any 
)ther text window. All footnotes are shown in this window. 
=1ootnotes are automatically numbered and always stay on 

Footnote Placlng .. . 

Go To Reference 

:he same page as the text to which they are attached, unless otherwise specified. 
fhis window has its own menu to the right of the Style menu. 
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Footnote Symbol: Allows you to choose which type of symbol to use for 
the footnotes: numbers, numbers followed by periods, asterisks, etc. 

Footnote Pl acing: Controls the placement options of the footnotes, allows 
the option for endnotes, and controls the separator line. 

Go To Reference: Allows you to go to the current footnote reference. 

FORMAT MENU 

lnse( Page Break 
When choosing this command, the text immediately following the insertion point 
advances to the top of the next page. This is called a forced (explicit) page break. 

Keep On Same Page 
Groups the selection to always remain on the same page or column. 

Insert Date 
Inserts the variable date. 

Insert Time 
Inserts the variable time. 

Insert Doc Name 
Inserts the variable document name. 

Insert Page # 
Inserts the variable page number. 

Update Time & Date 
Updates all time and date variables in the document. 

Set Date & Page # Formats ... 
~h~~es the manner in which date arid page number variables are displayed for 
111d1v1dual documents. Time is set in the Control Panel under the sApple 
menu. 

Mark Index 
Highlights the selected text with a dotted box and remembers it as an index 
selection. To see the dotted boxes, choose Te Ht Hilltes from the Display submenu 
under the Tools menu. 

Unmark Index 
Select an indexed text entry or part of one and choose this function to remove it 
~om the index. -::ius command shows in place of Mark Ind e H when the selection 
is marked as an index selection. 

Remove from Index 
(Shift) Mark Ind e H. Select an indexed entry or a larger section of text and 
choose this function to remove all indexed text in that selection from the Index. 

Index As ... 
Allows you to index the selection as any key word or phrase. 
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Remove Index( ; 
(Shift) I ndeH As .... Select an Index As entry or a 
larger section of text and choose this function to 
remove all Index As text in that selection from the 
Index. 

Make Index ... 
Builds an index out of the Mark Index and Index As 
selections. A dialog comes up and you can choose 
the number of columns, the page number position, 
the justification and other formatting options. The 
Index is a separate document from the one it origi­
nated from. If you edit the original document further, 
you may have to make a new index. 

Mark Contents 
Highlights the selected text with a dotted box and 
remembers it as a Contents selection. To see the 
dotted boxes, choose TeHt Hllites from the Display 
submenu under the Tools menu. 

Unmark Contents 

Modified Format Menu 

w 
Insert Ruler 
Insert Header 
lnurt Footer 
Insert Footnote 
Insert Page Brank 
Keep On Same Page 

Insert Date 
Insert Time 
Insert Doc Name 
Insert Page # 
Update Time & Date 
Set Date & Page# formats ... 

[!!!!moue _!_ram _l_ndeH] 
[Remoue lndeH R!f 
Mnke J:ndeH ... 
jnemoue from Eonlenlsj 
Mnke Contents ... 

Shift 

Select a contents text entry or part of one and choose this function to remove it 
from the Table of Contents. This command shows in place of Merk Contents 
when the selection is marked as an Index selection. 

Remove from Contents 
(Shift) Merk Contents. Select a contents entry or a larger section of text and 
choose this function to remove all contents text in that selection from the Table of 
Contents. 

Make Contents ... 
Builds a Table of Contents out of the contents selections. A dialog comes up and 
you can choose the number of columns, the page number position and justification. 
The Table of Contents is a separate document from the one it originated from. If 
you edit the original document further, you may have to make a new Table of 
Contents. 
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=========================Font Menu 

Italic Font Names 
An italicized font in your Font menu means it is not in 
your system but has been used in your document. It will 
not appear on screen as that font, but you can use it to 
further edit your document. If you open your document on 
a ~omp~ter using a system with that font, it will appear and 
pnnt with that font. Otherwise, that font will print in Geneva. 

Any Font 
1;Jsed for Fin~/Replece ... on the Tools menu, Oipboard 
files, Macro files and Glossary files. It represents any text 
regardless of font. 

Font Menu 

Chicago 
Digit alDraw 
Electronlc 
ElectronlcDrnw 
Geneuo 
Heluetlco 

.,..Pnlotlno 
Scientific 
SubSclentlflc 
SuperSclentlflc 
Symbol 
Times 
Curs/J1t1 
Dlg/111/ 
rr1r.t/011 
Rny Font 

========================= Size Menu 

Size Menu 
Other(#) ... 

ID IPCD!IlJQ 
DID 

Allows you to choose sizes not otherwise available on the 
Size menu. 

v'O?.I 
0<() 
DID 
?,I<() 
28 
36 
48 
72 
COOllxw ao m­
nny Size 

Increase 
Decrease 

Any Size· 

Increase/Decrease 
Changes the font size of selected text in I 
point increments. 

Increase By .• ./Decrease By ... 
(Shift) Increase or (Shift) Decrease. 
Changes the font size of selected text in user 
defined point increments. 

1!sed for Fin.d/Replece ... on the Tools menu, Clipboard 
files, Macro files and Glossary files. It represents any text re­
gardless of size. 
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Modified 
Size Menu 

Ill IPOODQ 
om 

v'O!I 
0.() 
om 
31.() 
28 
36 
48 
72 
C0011xw aom­
nny Size 

Increase e ... 
Decrease B ... 

Shift 
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============================== Sty I e Menu 
Style Menu 

+- Any Styles 
""Plnln XP 

Jsed for Find/Replace ... on the Tools menu, Clipboard 
:iles, Macro files and Glossary files. It represents any text 
:egardless of any additional unchecked styles. 

l•I• XO 
/111/r. XI 

J!.nJ1.H11.ni. IC U 
Superscript 
Subscript 

More Styles 
+ Rny Styles 
More style• ~ 
Color ~ 

3ubmenu including the less usual styles for type. 
Denne St le ... Outline: Outlines characters, leaving the insides white. 

Shadow: Outlines characters and puts a shadow under them. 

Condense: Condenses characters: makes them look narrower. 

Extend: Extends characters: makes them look wider. 

Lower Underline: Underlines lower than the basic underline. 

Dotted Underline: Underlines with a dotted line. 

Word Underline: Underlines words but not spaces. 
Superscript 2: Second level superscript. Moves the text up in relation to 
the first level superscript or subscript. Examples: x0 x •• 

~ 
OOIGXllaXIll 
Condense 
EH tend 
Lower Underline 
D.oJ!ed Underline 
.Ll!.wl llrul.e.r1J.n.A 
Superscript 2 
Subscript 2 
strike Thruuyh 
Ouerbnr 

Subscript 2: Second level subscript. Moves the text down 
in relation to the first level subscript or superscript. 
Examples: x. x"" • 
Strike Through: Puts a line through the characters. 

Overbar: Puts a line above the ascent line of the characters. 

Box: Puts a box around each word, separated by a space. 

Invisible: Can be made visible and printable with I nuls­

lble TeHt in the Display submenu of the Tools menu. 
This style is good for making notes within your document 
that you want hidden for printing purposes. 

Color .,...Bl11c1c 
Red Submenu including an 8 color scale. Any Color is included for 

Find/Replace .... Color is recognized on black and white moni­
tors. 

Define Style ... 
This brings up a dialog where font, size and style attributes can be 

Green 
Blue 
Cynn 
M11gent11 
Yellow 
White 
R!!JI. Color 

chosen and named as a single style. The user styles designed will appear at the 
bottom of the Style menu, ready to be used like regular styles. 
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--\ ==================== Graphics Me rr- , 

The Graphics Menu 
The Graphics menu appears to the right of the Sty I e menu 
when Graphics Palette is chosen from the Display 
submenu under the Tools menu, or the Graphics Palette 
icon ~in the vertical scroll bar is clicked. 

Bring To Front/Send To Back 
For graphics which overlap, these commands let you control 
which graphic is in front of or behind the other. 

Group 
Groups several selected graphics together as one. Simplifies 
moving, scaling and duplicating. 

Ungroup 

Graphics Menu 

Bring To Front 
Send To Boele 
Group 
Ungroup 
Set Wrop Border ... 
Sc11le ... 
Duplication ... 
Rotate Right 9U' 
Set Round Rech ... 
Show Paste Spot 

,,.Len Justify 
Center Jusury 
Right Justl![ 

Ungroups selected graphics which have previously been grouped. 

Set Wrap Border ... 
Sets the borders (in pixels or dots) to the right and left of a graphic which has the 
Text Wrap On attribute. 

Scale ... 
Scales the selected graphic to a user defined percentage. Controls the option of 
whether to scale the pen and graphic text, as well as the graphic itself. 

Quick Scale 
(Shift) Sc a I e .... Scales the selected graphic to the percentage defined in the 

Scale ... dialog, without entering the dialog. 

Unscale 
(option) Scale .... Unscales a scaled graphic, as long as it is the original graphic 
which was scaled in Nisus. Unscaleable graphics include those drawn with the 
polygon tool, the Freehand Drawing tool and PICT's. Does not unscale copies of 
scaled graphics. 

Duplication ... 
Duplicates the selected graphic to a user defined number. Controls where the 
duplicates are pasted in relation to the original and each other. 
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Quick Duplicatr 
[Shift) Duplication.~ .. Duplicates the 
selected graphic to that defined in the 
Duplication ... dialog, without enter­
ing the dialog. 

Rotate Right goo 
Rotates a graphic 90° to the right. 

Rotate Left goo 
(Shift) Rotate Right 90°. Rotates a 
graphic 90° to the left. 

Un rotate 

Modified Graphics Menu 

JmimlllJ1~--. 2 
Bring To Front Bring To Front 
Send To B11clc Send To B11clc 

Set Round Rech ... 
Show P11•te Spot 

.llefl Justify 
Center Justify 
RI ht Justlf 

1) Shift 

.llefl Justify 
Center Justify 
RI hi Justlf 

2) Option 

@§il Rotate Right 90°. Unrotates a graphic which was rotated in Nisus. 

Set Round Rects ... 
Dialog used to change the curve of the corner of the Rounded Rectangle tool l 0 I . 
(You can also double-click on the Rounded Rectangle tool to access this dialog.) 

Show Paste Spot 
Shows a corner marker !'" on the top left corner of where the next graphic will 
be pasted. It is located at the last place you clicked in the document. 

Left Justify 
When you are using the Text tool CT] on the Graphics Palette, this command left 
justifies your text . 

Center Justify 
When you are using the Text tool CT] on the Graphics Palette, this command 
center justifies your text - . 

Right Justify 
When you are using the Text tool CT] on the Graphics Palette, this command 
right justifies your text . 
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=====================Graph i cs Pa I ette 

Graphic Anchors 
A pull-down menu determining whether a graphic is fixed to 
a page or attached to a paragraph. To show graphic attachment, 
choose Graphic Anchors from the Display submenu under 
the Tools menu. 

Fix to Page [QJ: Fixes the graphic to a page. 

I) FIH lo P11ge .I, Move with 'I 

Move With ~[I]: Attaches the graphic to a paragraph. The graphic moves 

with the paragraph as the text is edited. If the paragraph to which the graphic 

is attached is deleted, the graphic will also be deleted. If the paragraph is 

copied, the graphic is also copied. 

Graphics Sheets 
A pull-down menu determining whether a graphic is on the Front of TeHt 
sheet or the Behind TeHt sheet. 

Front of Text ~: One of the two graphics sheets. The 

graphics with this attribute lie over (in front of) the text. 

Behind Text [I]: One of the two graphics sheets. The graph­
ics with this attribute lie under (behind) the text. 

Text Wrapping 
A pull-down menu determining whether text wraps around 
or flows through a graphic. 

Text Wrap On ~: Text wraps around a graphic with 

this attribute. There is a user defined Wrap Border to the right and left of the 

graphic. It is defined using the Set Wrap Border ... dialog found in the 
Grnphics menu. 

Text Wrap Off [I}: Text flows through the graphic, rather than wrapping 
around it. 
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Transfer Mode ( 
A pull-down menu determining whether a graphic is in the Opaque, Transparent 
or Invert mode. Transparent and Invert will not print on a PostScript® printer. 

Opaque ~: Graphics with this attribute are opaque. Set all graphics to 
this attribute when printing using a PostScript printer. To make a graphic 

transparent while in the Opaque mode, set the fill pattern to None (N). 

Transparent [!li): Graphics with this attribute are transparent, but do not 

print as such when using a PostScript printer. PostScript does not support 

the Transparent mode. 

._J 

.1Q] Opaque 
li!J Transparent 
!ID I nuert 

Invert ~:Wherever two graphics of the same color intersect, 

they will invert at those places. They do not print as such 

when using a PostScript printer. PostScript does not support 
the Invert mode. 

Tool Palette 
Selection tool, Line tool, Arrow tool, Bidirectional Arrow tool, Arc tool, Text tool, 
B"-l\.l"»j r j T j Rectangle tool, Rounde~ Rectangle tool, Oval tool, Polygon 
D DIO CT c::? tool and Freehand Drawmg tool. 

i±i:: :~: Pen Size Selector 
... - -v,- Determines the line weight of the pen. 

Fill Pattern Selector 
Determines the fill pattern of an object graphic. 

I~~ Pen Pattern Selector 
Determines the pen pattern of an object graphic. 

~ Black, White and None (N) Patterns 
W For use with the Fill/Pen Pattern Selector. None (N) is transparent. 

r;;i Pattern Scroll 
U Scrolls the Pattern Palette in either direction. 

Pattern Palette 
Patterns for fills and lines. 
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